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This preface describes the contents of the Virtual Infrastructure Web Access 
Administrator’s Guide and provides pointers to VMware® technical and educational 
resources. 

This preface contains the following topics:

! “About This Book” on page 7

! “Technical Support and Education Resources” on page 9

About This Book
This manual, the Virtual Infrastructure Web Access Administrator’s Guide, provides 
information on how to configure virtual machines for ESX Server and VirtualCenter 
Server.

Revision History
This manual is revised with each release of the product or when necessary. A revised 
version can contain minor or major changes. Table P-1 provides you with the revision 
history of this manual.

Preface

Table P-1.  Revision History

Revision Description

20060615 ESX Server 3.0 and VirtualCenter 2.0 version of the Virtual Infrastructure 
Web Access Administrator’s Guide. This is the first edition of this manual.

20060925 ESX Server 3.0.1 and VirtualCenter 2.0.1 version of the Virtual Infrastructure 
Web Access Administrator’s Guide. This edition includes minor changes to 
virtual hardware configuration information.
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Intended Audience
The information presented in this manual is written for experienced system 
administrators who are familiar with Windows or Linux virtual machine technology 
and datacenter operations.

Document Feedback 
If you have comments about this documentation, submit your feedback to: 

docfeedback@vmware.com

VMware Infrastructure Documentation
The VMware Infrastructure documentation consists of the combined VirtualCenter and 
ESX Server documentation set. 

You can access the most current versions of this manual and other books by going to:

http://www.vmware.com/support/pubs

Conventions 
Table P-2 illustrates the typographic conventions used in this manual. 

Abbreviations Used in Graphics
The graphics in this manual use the abbreviations listed in Table P-3.

Table P-2.  Conventions Used in This Manual

Style Elements

Blue (online only) Cross-references and email addresses

Blue boldface (online only) Links

Black boldface User interface elements such as button names and menu items

Monospace Commands, filenames, directories, and paths

Monospace bold User input

Italic Document titles, glossary terms, and occasional emphasis

< Name > Variable and parameter names

Table P-3.  Abbreviations

Abbreviation  Description

VC VirtualCenter

VI Virtual Infrastructure Client

mailto:docfeedback@vmware.com
http://www.vmware.com/support/pubs
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Technical Support and Education Resources
The following sections describe the technical support resources available to you.

Self-Service Support
Use the VMware Technology Network (VMTN) for self-help tools and technical 
information:

! Product information – http://www.vmware.com/products/

! Technology information – http://www.vmware.com/vcommunity/technology

! Documentation – http://www.vmware.com/support/pubs

! VMTN Knowledge Base – http://www.vmware.com/support/kb

! Discussion forums – http://www.vmware.com/community

! User groups – http://www.vmware.com/vcommunity/usergroups.html

For more information about the VMware Technology Network, go to 
http://www.vmtn.net.

Online and Telephone Support
Use online support to submit technical support requests, view your product and 
contract information, and register your products. Go to 
http://www.vmware.com/support.

server VirtualCenter Server

database VirtualCenter database

hostn VirtualCenter managed hosts

VM# Virtual machines on a managed host

user# User with access permissions

dsk# Storage disk for the managed host

datastore Storage for the managed host

SAN Storage area network type datastore shared between managed hosts

tmplt Template

Table P-3.  Abbreviations

Abbreviation  Description

http://www.vmware.com/products/
http://www.vmware.com/vcommunity/technology
http://www.vmware.com/support/pubs
http://www.vmware.com/support/kb
http://www.vmware.com/community
http://www.vmware.com/vcommunity/usergroups.html
http://www.vmware.com/vcommunity
http://www.vmware.com/support
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Customers with appropriate support contracts should use telephone support for the 
fastest response on priority 1 issues. Go to 
http://www.vmware.com/support/phone_support.html.

Support Offerings
Find out how VMware support offerings can help meet your business needs. Go to 
http://www.vmware.com/support/services.

VMware Education Services
VMware courses offer extensive hands-on labs, case study examples, and course 
materials designed to be used as on-the-job reference tools. For more information about 
VMware Education Services, go to http://mylearn1.vmware.com/mgrreg/index.cfm.

http://www.vmware.com/support/phone_support.html
http://www.vmware.com/support/services
http://mylearn1.vmware.com/mgrreg/index.cfm
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This chapter introduces Virtual Infrastructure (VI) Web Access components and 
operations. This chapter contains the following topics:

! “What Is Virtual Infrastructure Web Access?” on page 12

! “Key Features” on page 12

Introducing VMware Virtual 
Infrastructure Web Access 1
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What Is Virtual Infrastructure Web Access?
VI Web Access is a browser-based application designed to manage virtual machines on 
ESX Server and VirtualCenter deployments. This version of VI Web Access focuses on 
virtual machine management, and pays attention to:

! System administrators who need to access virtual machines without a VI Client

! People who use virtual machines as remote desktops

! Virtual Infrastructure administrators who need to interact with virtual machines 
remotely

The VI Web Access interface provides a powerful overview of all the virtual machines 
on an ESX Server system and VirtualCenter Server. Using Virtual Infrastructure Web 
Access to manage virtual machines, you can:

! View hosts and the virtual machine details using a Web browser

! Perform power operations on virtual machines

! Edit a virtual machine’s configuration and hardware

! Generate Remote Console URLs that users can utilize to access their virtual 
machines

! Interact with the guest operating systems running within the virtual machines

! Access ESX Server hosts and VirtualCenter Servers from Linux systems

VI Web Access focuses on virtual machine management, and does not offer the full 
range of administrative tasks available through the VI Client.

Key Features
The key features of VI Web Access are described below.

Virtual Machine Management
Users can access virtual machine status information and power controls by connecting 
directly to an ESX Server host or a VirtualCenter Server. 

Users can interact with virtual machines using the keyboard and mouse in window or 
full screen mode from any compatible web browser.

Remote Console URLs
Users can share virtual machines with customized controls and environments using 
ordinary Web browser URLs. 
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Each URL provides direct access to a specific virtual machine from supported Web 
browsers.

Usability
Administrators can provide end users with access to virtual machines. 

Users can access virtual machines on ESX Server hosts and VirtualCenter Servers 
without installing the Virtual Infrastructure client.

Users and Administrators can use VI Web Access to access ESX Server hosts and 
VirtualCenter Servers from both Linux and Windows systems.

Client devices allow people to use Floppy and CD/DVD Drives from their own 
computers to install software or copy data.

Simplified Remote Console Use
People can complete their work without distractions by customizing remote console 
URLs that present only as many user interface controls as necessary. 
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This chapter introduces VI Web Access components and operations. This chapter 
contains the following topics:

! “Virtual Infrastructure Web Access Requirements” on page 16

! “Installing Virtual Infrastructure Web Access” on page 17

! “Running and Configuring Virtual Infrastructure Web Access Service” on page 17

! “Setting Virtual Infrastructure Web Access Passwords” on page 17

! “Installing the VMware Virtual Infrastructure Web Access Plug-In” on page 18

System Requirements and 
Web Browser Configuration 2
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Virtual Infrastructure Web Access Requirements
The following sections outline the system and browser requirements for using VI Web 
Access:

! “System Requirements” on page 16

! “Browser Requirements” on page 17

System Requirements

PC Hardware
! Standard x86-based computer

! 266MHz processor minimum (500MHz or faster recommended)

! 128MB RAM minimum (256MB or more recommended)

! 20MB (for Windows hosts) or 10MB (for Linux hosts) free disk space to install the 
VMware Virtual Infrastructure plug-in

Operating Systems

Windows
! Microsoft Windows 2003 Web Edition Service Pack 1, Windows 2003 Standard 

Edition Service Pack 1, or Windows Server 2003 Enterprise Edition Service Pack 1

! Windows XP Professional Service Pack 2 or Windows XP Home Edition Service 
Pack 2

! Microsoft Windows 2000 Professional Service Pack 4, Windows 2000 Server 
Service Pack 4, or Windows 2000 Advanced Server Service Pack 4

Linux
! Linux kernel 2.2.14 or higher
! glibc 2.3.2 or higher
! XFree86-3.3.6 or higher
! gtk+2.0 or higher
! fontconfig (also known as xft) 
! libstdc++5 or higher
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Browser Requirements 
To access VMware Virtual Infrastructure Web Access, you should be running one of the 
following: 

! Internet Explorer 6.0

! Mozilla Firefox 1.0.8 or higher for Microsoft Windows 

! Mozilla Firefox 1.0.8 or higher for Linux

Installing Virtual Infrastructure Web Access
VI Web Access is automatically installed when ESX Server is installed. On 
VirtualCenter Server, VI Web Access can be installed from the VirtualCenter Server 
Windows setup package. 

Running and Configuring Virtual Infrastructure Web 
Access Service

To connect to an ESX Server host or VirtualCenter Server with VI Web Access, the VI 
Web Access service must be running on the host or server. VI Web Access connections 
are available by default with ESX Server and VirtualCenter Server. 

Setting Virtual Infrastructure Web Access Passwords
Administrators must have a valid user name and password to access ESX Server hosts 
and VirtualCenter Servers using VI Web Access. The password defaults are as follows:

! ESX Server — The default user is root. The root password is configured during the 
installation of ESX Server.

! VirtualCenter Server — The default user is Administrator. The Administrator 
password is configured during the installation of VirtualCenter Server. 
Administrators can add users and groups to allow users access to VI Web Access.

For more information on setting passwords during installation, refer to the VMware 
ESX Server Installation Guide.

NOTE Other browsers are not actively excluded, but VMware has certified VI Web Access with 
only the browsers listed above. Please refer to your browser vendor's own 
documentation for additional requirements. For the best experience, make sure your 
browser includes all of the security and stability updates recommended by its vendor.
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Installing the VMware Virtual Infrastructure Web Access 
Plug-In

To run VI Web Access, you must install the VMware Virtual Infrastructure plug-in. To 
install VMware Virtual Infrastructure ActiveX Control in Microsoft Internet Explorer

1 In the Internet Explorer window, type the VI Web Access URL:

<https://vmwarehost.yourdomain.com/ui>

2 Log in to VI Web Access using the user name and password for the host to which 
you are connecting.

3 Select a virtual machine from the Virtual Machines list. 

4 Click the Console tab. 

If prompted, click Install in the pop-up box. You may need to refresh your browser 
after installation.

To install the VMware Virtual Infrastructure plug-in in Mozilla Firefox for Linux 
and Windows

1 In the Firefox window, type the VI Web Access URL:

<https://vmwarehost.yourdomain.com/ui>

2 Log in to VI Web Access using the user name and password for the host to which 
you are connecting.

3 Select a virtual machine from the Virtual Machines list. 

4 Click the Console tab. 

5 Click Install Plugin.

The Plugin dialog box appears.

6 Click Edit Options.

7 Click Allow.

8 Click Close.

9 Click Install Plugin.

The software installation dialog box appears.

10 Click Install Now.

11 After the installation is complete, choose View > Reload to reload the page. 
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Troubleshooting
The following section walks you through common VI Web Access troubleshooting 
scenarios.

Troubleshooting Your VI Web Access Connection
If you are unable to connect to your ESX Server host using VI Web Access, you might 
need to restart the VI Web Access service on your host.

To troubleshoot VI Web Access service on an ESX Server host

1 Log directly into your ESX Server service console.

2 Enter service vmware-webAccess status to check the status of the host’s VI 
Web Access service.

3 If VI Web Access service is stopped, enter service vmware-webAccess start.

If the Console does not load properly, you may need to troubleshoot the plug-in 
installation.

To check the plug-in version in Mozilla Firefox

1 Go to about:plugins in the browser

2 VMware WebCenter Remote MKS Plug-in should show version 2.0.1.0

3 If any other version number appears, you must re-install the plug-in

To check the plug-in version in Microsoft Internet Explorer

1 Go to Tools > Internet Options.

2 Click Settings.

3 Click View Objects.

4 The Version column for QuickMksAxCtl should show 2,0,1,0

5 If any other version number appears, right click QuickMksAxCtl, and select 
Remove.

6 Re-install the plug-in.

To troubleshoot the plug-in installation in Mozilla Firefox

1 Quit Firefox. Choose File > Quit. 

2 Launch Firefox again. 



Virtual Infrastructure Web Access Administrator’s Guide

20 VMware, Inc.  

3 In the Firefox window, type the VI Web Access URL:

<https://vmwarehost.yourdomain.com/ui>

4 Select a virtual machine from the Virtual Machines list. 

5 Click the Console tab. 

6 When you are prompted to install the plug-in, click OK. 

7 After the installation is complete, choose View > Reload to reload the page. 

To troubleshoot the plug-in installation in Microsoft Internet Explorer

1 Quit Internet Explorer. Choose File > Close. 

2 Launch Internet Explorer again. 

3 In the Internet Explorer window, type the VI Web Access URL:

<https://vmwarehost.yourdomain.com/ui>

4 Select a virtual machine from the Virtual Machines list. 

5 Click the Console tab. 

6 When you are prompted to install the plug-in, click OK. 

7 After the installation is complete, choose View > Refresh to reload the page. 

Troubleshooting Virtual Machine Power Operations
There are several reasons why you might be unable to power on a virtual machine.

! You are missing the required libraries.

To correct this problem, you must use a dependency checker such as ldd against 
libmks.so, viewer, and remotemks binaries. Take the following steps to determine 
the missing libraries.

a cd into ~/.mozilla/plugins

b ldd ./libmks.so | grep not

c ldd ./viewer | grep not

d ldd ./remotemks | grep not

The output from steps b, c, and d indicate missing libraries. If these steps produce 
no output, all required libraries are available.

! You are running a non-GTK Mozilla browser.
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To correct this problem, use a GTK-based Mozilla browser, available at 
www.mozilla.org.

! You are running a version of Firefox that came with your Linux distribution. Some 
distributions package Firefox incorrectly, and the resulting package does not work 
with VI Web Access.

To correct this problem, get the latest version of Firefox from www.mozilla.org.

http://www.mozilla.org
http://www.mozilla.org
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This chapter guides you through the basic tasks you must complete to begin using VI 
Web Access.

This chapter includes the following topics:

! “Connecting to Virtual Infrastructure Web Access” on page 24

! “Logging Out” on page 25

! “Overview of the Virtual Infrastructure Web Access Default View” on page 25

Getting Started with Virtual 
Infrastructure Web Access 3
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Connecting to Virtual Infrastructure Web Access
After your user name and password are authorized by VI Web Access, the VI Web 
Access home page appears. The VI Web Access home page contains:

! High-level details about all the virtual machines on the server to which you are 
connected

! The option to access the details page for a virtual machine where you find 
information about virtual devices, configuration options, and a summary of recent 
Events

To log in to VI Web Access

1 Launch your Web browser.

2 Enter the URL of your ESX Server or your VirtualCenter Server installation:

https://<host or server name>/ui

The Web Access login page appears.

The login page contains fields for your user name and password.

3 Enter your user name and password, and click Log In. 

The VI Web Access home page appears. For information about the Status Monitor 
page, see “Overview of the Virtual Infrastructure Web Access Default View” on 
page 25. 

To log out of VI Web Access, see “Logging Out” on page 25.

NOTE If you have a pop-up blocker enabled, you will receive a message from VI Web Access 
saying that a pop-up blocker has been detected. You must disable your pop-up blocker 
in order to use client devices.
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Logging Out
You can log out of VI Web Access by clicking the Log Out link found at the upper-right 
corner of every page. If you have active client device connections, you are prompted to 
confirm that you want to log out.

Logging out disconnects client devices that any of the virtual machines are using. 

Overview of the Virtual Infrastructure Web Access 
Default View

The following sections describe the VI Web Access interface and components: 

! “Workspace” on page 26

! “Menu Bar” on page 27

! “Toolbar” on page 30

! “Inventory Panel” on page 32

The VI Web Access default view contains a high-level view of the ESX Server or 
VirtualCenter Server that you are logged in to, including a list of all registered virtual 
machines and their status.

Figure 3-1.  Web Access Home Page View

The VMware VI Web Access window is divided into four main sections:

! Inventory panel — Appearing on the left, this area displays a list of virtual 
machines (ESX Server) or the virtual machine hierarchical inventory 
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(VirtualCenter Server). Click a virtual machine to display information about the 
virtual machine and available options for the virtual machine.

! Workspace — Appearing on the right, this is the main part of the window. When 
the host (ESX Server) or a datacenter or folder (VirtualCenter Server) is selected in 
the inventory panel (see below), you can view a list of all the virtual machines 
contained by the selected object. When a virtual machine is selected, the workspace 
provides detailed information about various aspects of the virtual machine.

! Menu bar — The menu items along the top of the VI Web Access window provide 
access to common virtual machine operations, such as power on and enter full 
screen mode. 

! Toolbar — These buttons along the top allow you to act on the selected virtual 
machine, offering one-click access to operations such as power on and enter full 
screen mode.

Workspace
When you select a virtual machine, the workspace provides detailed information about 
various aspects of the virtual machine. You can view a summary of the virtual 
machine’s state, interact with the guest operating system using a remote 
mouse-keyboard-screen (MKS), and view details about Alarms (VirtualCenter), Events, 
and Tasks (VirtualCenter).
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Figure 3-2.  Virtual Machine Information Panel

Administrators can configure a URL for any virtual machine that displays only the 
Remote Console tab, allows or disables access to the virtual machine and its Workspace 
tabs, and that allows or disables access to the entire virtual machine inventory. See 
“Creating and Sharing Remote Console URLs” on page 42 for more information.

Menu Bar
The menu bar provides access to all commands.

Figure 3-3.  Web Access Menu Bar
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The menu bar options are:

! Web Access menu — Displays options relevant to VI Web Access.

! View menu —Controls which panes are visible. 

! Virtual Machine menu — Is enabled only when a virtual machine is selected in the 
inventory panel.

The Web Access menu bar options are covered in the following sections:

! “Web Access Menu” on page 28

! “View Menu” on page 28

! “Virtual Machine Menu” on page 29

Web Access Menu
The Web Access menu lists general VI Web Access options for getting help and logging 
out.

Figure 3-4.  Web Access Menu

! About — Displays the Web Access version number, the ESX Server or 
VirtualCenter Server version number, and VMware copyright information. 

! Help — Displays the online help contents.

! Log Out — Logs you out of VI Web Access.

View Menu
The virtual machine View menu lists options for managing inventory and tab views on 
the VI Web Access home page.
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Figure 3-5.  Web Access View Menu

Inventory View Options
The inventory panel displays a list of inventory objects. Display options include:

! Expand Sidebar — Expands the inventory panel. 

! Collapse Sidebar — Collapses the inventory panel. When collapsed, the inventory 
panel is a strip along the left side of the VI Web Access window. Click the arrows 
in the strip to expand or collapse the inventory panel.

! Hide Sidebar — Hides the inventory panel. When the inventory panel is hidden, 
you cannot access the inventory panel unless you deselect this view option.

Virtual Machine Tab View Options
The virtual machine tabs appear at the bottom of the information panel. Display 
options include:

! Show Tabs — Displays the Summary, Events, Alarms (VirtualCenter only), Tasks 
(VirtualCenter only), and Console tabs for the virtual machine.

! Hide Tabs — Hides the Summary, Events, Alarms (VirtualCenter only), Tasks 
(VirtualCenter only), and Console tabs for the virtual machine.

Virtual Machine Menu
The Virtual Machine menu lists options for managing the power state of a virtual 
machine and for viewing the console.
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Figure 3-6.  Web Access Virtual Machine Menu

The menu includes the following commands, some of which can be performed using 
the buttons and other visual elements of the management interface:

! Power On— Powers on a stopped virtual machine.

! Resume — Resumes a suspended virtual machine. 

! Power Off — Powers off the virtual machine immediately. This is the same as 
turning off the power to a physical computer. 

! Suspend — Suspends a powered-on virtual machine. 

! Reset — Resets the virtual machine immediately. This is the same as pressing the 
reset button on a physical computer. 

! Shutdown Guest —Shuts down the guest operating system. 

! Restart Guest — Restarts the guest operating system and the virtual machine.

! Enter Full Screen Mode – Puts the virtual machine console in full screen mode.

! Send Ctrl+Alt+Del – Sends Ctrl+Alt+Del to the virtual machine.

Toolbar
The toolbar at the top of the VI Web Access page contains buttons you can click to 
power your virtual machines on and off.

Figure 3-7.  Toolbar for Virtual Machine
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The following table describes the toolbar actions.
Button Actions

Depending on how you have configured the power options for this 
virtual machine, this button either shuts down the guest operating 
system or powers off the virtual machine (see “Changing Power State 
Options” on page 103). When this icon is red, the virtual machine is 
powered off. 

Suspends a running virtual machine or resumes a suspended virtual 
machine. VMware Tools executes the script associated with this power 
state change, if any. When this icon is amber, the virtual machine is 
suspended.

Powers on a stopped virtual machine or resumes a suspended virtual 
machine. VMware Tools executes the script associated with this power 
state change, if any. When this icon is green, the virtual machine is 
running.

Depending on how you have configured the power options for this 
virtual machine, this button either restarts the guest operating system 
or resets the virtual machine (see “Changing Power State Options” on 
page 103).

Enlarges the virtual machine display to cover the entire Web Access 
window. This option is enabled only when a virtual machine is running 
and the Console tab is selected.

Takes you to the network adapter configuration page. A red X over the 
icon indicates that the network adapter is not connected.

 Takes you to the CD/DVD Drive configuration page. A red X over the 
icon indicates that the CD/DVD Drive is not connected.

Takes you to the Floppy Drive configuration page. A red X over the 
icon indicates that the Floppy Drive is not connected.
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Inventory Panel
This panel displays the virtual machine inventory. You can collapse and expand the 
inventory panel with a single click. 

Administrators can configure a URL that does not show the inventory panel. 

Figure 3-8.  Virtual Machine Inventory
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This chapter describes the various aspects of using VI Web Access to manage virtual 
machines. This chapter contains the following sections:

! “Summary, Events, Alarms, Tasks, and Console Views” on page 34

! “Viewing Summary Information About Virtual Machines” on page 34

! “Viewing Virtual Machine Events” on page 36

! “Viewing Virtual Machine Alarms” on page 37

! “Viewing Virtual Machine Tasks” on page 38

! “Using the Console” on page 38

! “Installing VMware Tools in the Guest Operating System” on page 41

! “Changing the Power State of a Virtual Machine” on page 42

! “Creating and Sharing Remote Console URLs” on page 42

Using Virtual Infrastructure 
Web Access to Manage 
Virtual Machines 4
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Summary, Events, Alarms, Tasks, and Console Views
The workspace, which appears on the right side of the VI Web Access display, displays 
information about the selected virtual machine divided into multiple tabs.

Figure 4-1.  Virtual Machine > Summary, Events, Alarms, Tasks, and Console View

! Summary — Displays performance and status information. From this tab, you can 
modify the selected virtual machine’s hardware and configuration options.

! Events — Displays events that occurred for the virtual machine. Select an event to 
see its details in the Event Details field. 

! Alarms — Displays alarms. This tab is available only through VirtualCenter 
Server. 

! Tasks — Displays activities and activity details. This tab is available only when 
using VI Web Access to connect to a VirtualCenter Server. Tasks can be initiated 
manually or scheduled using the VI Client. Select a task to see its details in the Task 
Details field.

! Console — Allows users to interact directly with the guest operating system. See 
“Using the Console” on page 38.

Viewing Summary Information About Virtual Machines
When you select the Summary tab for a virtual machine, VI Web Access displays a 
summary of the configuration information about that virtual machine.
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Figure 4-2.  Virtual Machine > Summary Tab

The summary page contains the following information:

! Amount of server processor capacity that the virtual machine is currently using.

! Amount of server memory that the virtual machine is currently using.

! Current power state of the virtual machine: whether it is powered on, powered off, 
or suspended. For more information, see “Changing the Power State of a Virtual 
Machine” on page 42.

! Guest operating system installed in the virtual machine. 

! VMware Tools status, indicating whether VMware Tools is installed and running. 
A link to install or upgrade VMware Tools will appear when Tools is not installed 
or needs to be upgraded to the latest version. For more information, see “Installing 
VMware Tools in the Guest Operating System” on page 41.

! IP address and DNS name of the virtual machine. 
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! Links to edit or remove the virtual machine's hardware. To change most options, 
you must power off the virtual machine. For more information, see “Editing the 
Hardware Configuration of a Virtual Machine” on page 47.

! Links to add hardware to the virtual machine. For more information, see “Adding 
Hardware to a Virtual Machine” on page 67.

! Links to edit the virtual machine’s standard configuration options. To change most 
options, you must power off the virtual machine. For more information, see 
“Changing Virtual Machine Options” on page 102.

! Link to create a remote console URL of the virtual machine. For more information, 
see “Creating and Sharing Remote Console URLs” on page 42.

! Current relationships of the virtual machine: the name of the virtual machine’s 
host, datastores, and networks.

! Recent Tasks for the virtual machine.

! Recent Alarms for the virtual machine, when you are using VI Web Access to 
connect to a VirtualCenter Server.

Viewing Virtual Machine Events
The Events tab is available when you select a virtual machine from the inventory panel.

Figure 4-3.  Virtual Machine > Events Tab
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The Events list displays a sorted log of the most recent virtual machine transactions, 
such as questions ESX Server asks, errors, and other events like powering on or 
powering off the virtual machine.

You can sort events by clicking on the column headers. By default, events appear in 
reverse chronological order.

The event log draws its data from the log file for the virtual machine's configuration file. 
The log file is stored, by default, in the directory where the virtual machine is stored.

The Events tab content is described in the following table.

Viewing Virtual Machine Alarms
If you are using VI Web Access to connect to a VirtualCenter Server, the Alarms tab is 
available when you select a virtual machine from the inventory panel. Alarms are 
notifications that are triggered when specified events happen to a virtual machine, such 
as CPU usage exceeding the designated usage.

The Alarms tab content is described in the following table.

Field Description

Triggered Date and time the event occurred. 

Triggered By Entity that triggered the event.

Type Type of event that occurred. 

Message Text explanation of action. 

List Attribute Description

Last Triggered Date and time the alarm was most recently triggered.

Status Severity of the alarm.

Name Name of the alarm.

Description Description of the alarm.
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Viewing Virtual Machine Tasks
If you are using VI Web Access to connect to a VirtualCenter Server, the Tasks tab is 
available when you select a virtual machine from the inventory panel. Tasks are 
high-level actions, such as powering on a virtual machine, that are performed manually 
by a user or automatically on a schedule. Click a task’s triggered date and time to 
display its details, including related events, in the Task Details section.

The Task tab content is described in the following table.

Using the Console
The Console tab is available when you select a virtual machine from the inventory 
panel. If you need to interact with the guest operating system running in a virtual 

List Attribute Description

Triggered Date and time the task started.

Triggered By User or entity that initiated the task.

Status The state of the task: queued, in progress, error, or success.

Description Description of the task.
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machine, use the Console tab to connect remotely to the virtual machine’s mouse, 
keyboard, and screen (MKS).

When a virtual machine is powered off, suspended, or not available, or if the MKS 
plug-in is not installed, the Console tab displays a message and possible actions for the 
virtual machine.

Virtual machine states include:

! Powered Off — Provides the option to power on the virtual machine.

! Suspended — Provides the option to resume the virtual machine.

! Not Available — Provides the option to try again.

! Powering Off – No options available.

! Powering On – No options available.

! Suspending – No options available.

When the virtual machine is powered on, the Console tab displays the MKS of the 
virtual machine.
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Figure 4-4.  Inventory > Virtual Machine > Console Tab 

To interact with the guest operating system using your mouse or keyboard, click the 
virtual machine’s screen. To transfer control of your mouse and keyboard back to your 
computer, press Ctrl + Alt. If you have VMware Tools installed on the virtual machine, 
you can move the cursor in and out of the virtual machine to quickly switch mouse and 
keyboard control between the virtual machine and your computer.

Entering Full Screen Mode
When you select the Console tab, a full screen option is available. Select this option by 
clicking the full screen mode toolbar button ( ) or by pressing Ctrl + Alt + Enter. This 
option is enabled only when a virtual machine is running and the Console tab is 
selected. 

To exit full screen mode, press and release Ctrl + Alt.

Full screen mode Console tab Virtual machine’s desktop
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Installing VMware Tools in the Guest Operating System
VMware Tools is a suite of utilities that improves the performance of guest operating 
systems and enhances virtual machine management. For best results, VMware strongly 
recommends that you install VMware Tools in all of your guest operating systems.

Once your guest operating system is installed on a virtual machine, follow the 
directions below for installing or upgrading VMware Tools. 

To install VMware Tools

1 In the status section of a virtual machine’s summary, choose Install VMware 
Tools.

The VMware Tools installer has been inserted into your virtual machine's 
CD/DVD Drive.

2 Use the console to complete the installation.

This step connects the virtual machine’s CD drive to an installation file on the ESX 
Server machine or the VirtualCenter Server. If autorun is enabled in your guest 
operating system (the default setting for Windows operating systems), a dialog 
box appears after a few seconds. It asks if you want to install VMware Tools. Click 
Install to launch the Installation wizard.

3 Click the Console tab.

4 Restart the guest operating system when prompted.

To upgrade VMware Tools

1 In the status section of a virtual machine’s summary, click Upgrade VMware 
Tools.

The VMware Tools installer has been inserted into your virtual machine's 
CD/DVD Drive. 

2 Use the Console to complete the installation.

3 In a Windows guest, you must restart the guest operating system to complete the 
upgrade.
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Changing the Power State of a Virtual Machine
Depending on your permissions, you can use VI Web Access to change the power state 
of the virtual machine. To change a virtual machine’s power state, click the button in 
the toolbar that indicates the desired power state. 

Creating and Sharing Remote Console URLs
Using VI Web Access, you can create a remote console URL of a virtual machine using 
ordinary Web browser URLs. When creating a remote console URL, you can customize 
the VI Web Access user interface controls. Using remote console URLs, you can:

! Add the remote console URL to a list of favorite Web pages

! Share the remote console URL with one or more users in an e-mail message

Button Description 

Powers off the virtual machine. Depending on how you have 
configured the power options for this virtual machine, ESX Server 
might shut down the guest operating system before powering off the 
virtual machine (see “Changing Power State Options” on page 103). 
When this icon is red, the virtual machine is powered off. 

Suspends a running virtual machine or resumes a suspended virtual 
machine. VMware Tools executes the script associated with this power 
state change, if any. When this icon is amber, the virtual machine is 
suspended. 

Powers on a stopped virtual machine or resumes a suspended virtual 
machine. VMware Tools executes the script associated with this power 
state change, if any. When this icon is green, the virtual machine is 
running. 

Resets the virtual machine. Depending on how you have configured the 
power options for this virtual machine, ESX Server might shut down 
the guest operating system before resetting the virtual machine (see 
“Changing Power State Options” on page 103).

NOTE Shutting down or restarting a guest operating system works only when VMware Tools 
is installed. Otherwise, the power is turned off or the virtual machine is reset exactly as 
if you had pushed the power or reset button on a physical machine. For information on 
installing VMware Tools, see “Installing VMware Tools in the Guest Operating System” 
on page 41.
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To create a virtual machine remote console URL

1 In the status section of a virtual machine’s summary, click Generate Remote 
Console URL.

The Generate Remote Console URL page appears.

2 Choose user interface features.

You can allow or disallow full inventory and Workspace tab viewing.

3 Copy the remote console URL for further use. 

4 Click Close to return to the Summary tab. 

NOTE Administrators wishing to test a remote console URL should do so using a different 
browser or computer. If the remote console URL is tested on the administrator's active 
browser session, all instances of that browser will need to be closed before the 
administrator will be able to log back in with full user interface capabilities.
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5

This chapter describes the various aspects of using VI Web Access to configure virtual 
machines. This chapter contains the following sections:

! “Editing the Configuration of Existing Virtual Machines” on page 46

! “Understanding Permissions and Virtual Machines” on page 46

! “Using Client Devices” on page 46

! “Editing the Hardware Configuration of a Virtual Machine” on page 47

! “Adding Hardware to a Virtual Machine” on page 67

! “Changing Virtual Machine Options” on page 102

Editing an Existing Virtual 
Machine’s Configuration 5
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Editing the Configuration of Existing Virtual Machines 
To see more information about a virtual machine and to modify its configuration, click 
the virtual machine in the Inventory panel. The Summary tab displays the activities you 
can perform when viewing a virtual machine’s details. These activities include: 

! “Editing the Hardware Configuration of a Virtual Machine” on page 47

! “Adding Hardware to a Virtual Machine” on page 67

! “Changing Virtual Machine Options” on page 102

Understanding Permissions and Virtual Machines
Access to a virtual machine is based on the permissions you, as a user, are granted to 
the virtual machine's configuration file. Different permissions let you access virtual 
machines in different ways. These ways include: 

! Browsing virtual machines

! Interacting with virtual machines

! Configuring virtual machines

! Administering virtual machines

Depending on your permissions and the state of the virtual machine, some options 
might not be available. 

Using Client Devices
With ESX Server 3, you can connect some virtual devices to physical devices or ISO 
images located on the client machine. This is useful if you would like users to be able 
to use physical drives on their local machines rather than on the host system, or if you 
would like the virtual machine to access an ISO image located on the client computer.

Client devices are currently supported for CD/DVD and Floppy Drives.

NOTE Permissions are configured using the Virtual Infrastructure Client. For more 
information, see the VMware Infrastructure Basic System Administration Guide.

CAUTION When using client devices in a Linux guest, make sure that the device you 
are connecting to is not mounted or in use. If left mounted, the physical 
device will be unable to connect to the client device.
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Editing the Hardware Configuration of a Virtual Machine
The Hardware list on the virtual machine Summary tab lists the virtual hardware in the 
virtual machine, such as Memory, Hard Disks, CD/DVD Drives, and Network 
Adapters. You can configure each hardware component, but in some cases the virtual 
machine must be powered off to edit all of the component’s options.

Activities you can perform when editing the configuration of a virtual machine’s 
hardware include: 

! “Editing Processors” on page 47
! “Editing Memory Configuration” on page 48
! “Editing or Removing a CD/DVD Drive” on page 49
! “Editing or Removing a Floppy Drive” on page 51
! “Editing or Removing a Hard Disk” on page 52
! “Editing or Removing a SCSI Device” on page 59
! “Editing a SCSI Controller” on page 60
! “Editing or Removing a Network Adapter” on page 61
! “Editing or Removing a Parallel Port” on page 64
! “Editing or Removing a Serial Port” on page 65

Editing Processors
You can change the number of virtual processors used by your virtual machine.

To change the number of processors used

1 Select the virtual machine you want to modify from the inventory panel.

2 Make sure the virtual machine is powered off.

3 On the Summary page, click Processors.

The available processor configuration options appear under Commands.
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4 Click Edit.

The processor configuration page appears.

5 Choose the number of processors you would like for the virtual machine from the 
Processor Count drop-down menu.

6 Click OK to save your changes and to return to the Summary tab. 

Editing Memory Configuration
To edit Memory allocation

1 Select the virtual machine you want to modify from the inventory panel.

2 Make sure the virtual machine is powered off.

3 On the Summary page, click Memory.

The available Memory configuration options appear under Commands.

4 Click Edit.

The Memory device page appears.
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5 To ensure that the virtual machine will boot, allocate at least the Recommended 
Minimum Memory. 

6 Click OK to update the Memory setting and return to the Summary tab.

Editing or Removing a CD/DVD Drive
Virtual machines can access physical CD/DVD Drives on either the ESX Server host 
where the virtual machine is running or on your computer. They can access ISO images 
on the ESX Server file system or on remote datastores.

To edit an existing CD/DVD Drive

1 Select the virtual machine you want to modify from the inventory panel.

2 In the Summary page, click the CD/DVD Drive that you want to modify.

The available CD/DVD Drive configuration options appear under Commands.

3 Click Edit.

The CD/DVD Drive configuration page appears.
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4 The media source machine is selected at the top of the dialog box. Select an action:

! To connect the CD/DVD Drive to the ESX Server devices or files, select Host 
Media.

! To connect the CD/DVD Drive to devices on your computer, click Client 
Media. 

The remainder of the dialog box contents changes to accommodate the capabilities 
of the selected media source. For example, virtual machines cannot connect 
automatically to client media while powering on. Consequently, the Connect at 
power on check box is disabled if the Client Media option is selected.

5 To connect this virtual machine to the server's CD/DVD Drive when the virtual 
machine is powered on, select Connect at power on. 

6 Specify whether to connect to the server's CD/DVD Drive or to an ISO image. 
Select Physical Drive or ISO Image. 

7 Enter the location of the drive in the Physical Drive field or the location of the ISO 
image in the ISO Image field.

For example, the server's CD drive could be /dev/cdrom. 

8 Select the IDE device node from the IDE Device Node list. 

9 Click OK to save your changes and return to the Summary tab.

To remove an existing CD/DVD Drive

1 Select the virtual machine you want to modify from the inventory panel.

2 Make sure the virtual machine is powered off.

3 On the Summary page, click the CD/DVD Drive that you want to remove.

The available CD/DVD Drive configuration options appear under Commands.

4 Click Remove.

NOTE Client Media is supported on ESX Server 3 virtual machines only. For more 
information on client devices, see “Using Client Devices” on page 46.

NOTE When you click OK after connecting the drive to Client Media, VI Web Access launches 
a Device Status pop-up window. This window must remain open to keep the client 
device connected. Be sure to turn off pop-up blocking on your browser before 
connecting a drive to client media.
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Editing or Removing a Floppy Drive
Use VI Web Access to edit Floppy Drives attached to virtual machines. Each virtual 
machine can access a physical Floppy Drive or a Floppy image file on the host machine 
or on the client machine where you are running your browser. You can connect only 
one Floppy Drive to each physical drive on the client computer. A device can be 
connected to only one virtual machine on a server at a time.

To edit an existing Floppy Drive

1 Select the virtual machine you want to modify from the inventory panel.

2 In the Summary page, click the Floppy Drive you want to remove.

The available Floppy Drive configuration options appear under Commands.

3 Click Edit.

The Floppy Drive configuration page appears.

4 Choose the media type for the Floppy Drive:

! Host Media – Connects to a device or file on the host system.

! Client Media – Connects to a device or file on the client system.

NOTE Client Media is supported on ESX 3 virtual machines only. For more information 
on client devices, see “Using Client Devices” on page 46.
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5 To connect this virtual machine to the server’s Floppy Drive, select Connected.

Only one virtual machine can connect to a given Floppy Drive at a time. 

To connect this virtual machine to the server’s Floppy Drive when the virtual 
machine is powered on, select Connect at power on. 

6 To specify whether to connect to the server’s Floppy Drive or to a floppy image, 
select Physical Drive or Floppy Image. 

7 Enter the location of the drive or floppy image in the location field.

For example, the server's Floppy Drive could be /dev/fd0. 

8 Click OK to save your changes and return to the Summary tab. 

To remove an existing Floppy Drive

1 Select the virtual machine you want to modify from the inventory panel.

2 Make sure the virtual machine is powered off.

3 On the Summary page, click the Floppy Drive you want to modify.

The available Floppy Drive configuration options appear under Commands.

4 Click Remove to remove the Floppy Drive from the virtual machine, or click 
Delete from Disk to remove the Floppy Image from the virtual machine and delete 
the file from the host computer.

Editing or Removing a Hard Disk
To edit an existing virtual disk on an ESX 3 virtual machine

1 Select the virtual machine you want to modify from the inventory panel.

2 On the Summary page, click the Hard Disk you want to modify.

The Hard Disk options appear under Commands.

NOTE When you click OK after connecting the drive to Client Media, VI Web Access launches 
a Device Status pop-up window. This window must remain open to keep the client 
device connected. Be sure to turn off pop-up blocking on your browser before 
connecting a drive to client media.
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3 Click Edit.

The Hard Disk page appears.

4 Select the SCSI Device Node from the drop-down menu.

5 Choose whether to use the disk in Independent Mode. 

6 If you chose to use the disk in Independent Mode, select Persistent or 
Nonpersistent disk mode:

! Persistent — Disks in persistent mode behave like conventional disk drives on 
your physical computer. All data written to a disk in persistent mode is 
written out permanently to the disk. 

! Nonpersistent — Changes to disks in nonpersistent mode are not saved to the 
disks. Changes are lost when the virtual machine is powered off or reset.

NOTE If the hard disk you are configuring is the boot device for this virtual machine, click 
Modify the Device’s SCSI Node to change the SCSI Device node.
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Nonpersistent mode is convenient for users who always want to start with a 
virtual machine in the same state. Example uses include providing known 
environments for software test and technical support users, as well as 
demonstrating software. 

7 Click OK to save your changes and return to the Summary tab. 

To edit an existing virtual disk on an ESX 2.x virtual machine

1 Select the virtual machine you want to modify from the inventory panel.

2 On the Summary page, click the Hard Disk you want to modify.

The Hard Disk options appear under Commands.

3 Click Edit.

The Hard Disk page appears.
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4 Select the SCSI Device Node from the drop-down menu.

5 Choose the Disk Mode:

! Persistent — Disks in persistent mode behave like conventional disk drives on 
your physical computer. All data written to a disk in persistent mode are 
written out permanently to the disk. 

! Nonpersistent — Changes to disks in nonpersistent mode are not saved to the 
disks, but are lost when the virtual machine is powered off or reset.

Nonpersistent mode is for users who want to start with a virtual machine in 
the same state. Example uses include providing known environments for 
software test and technical support users, as well as demonstrating software.

! Undoable – Changes to disks in undoable mode can be saved, discarded, or 
appended when the virtual machine powers off.

! Append – Changes to disks in append mode are preserved in a redo log 
attached to the virtual disk.

6 Click OK to save your changes and return to the Summary tab. 

To edit an existing system LUN disk on an ESX 3 virtual machine

1 Select the virtual machine you want to modify from the inventory panel.

2 On the Summary page, click the Hard Disk you want to modify.

The Hard Disk options appear under Commands.

NOTE If the hard disk you are configuring is the boot device for this virtual machine, click 
Modify the Device’s SCSI Node to change the SCSI Device node.



Virtual Infrastructure Web Access Administrator’s Guide

56 VMware, Inc.  

3 Click Edit.

The Hard Disk page appears.

4 Select the SCSI Device Node from the drop-down menu.

5 Choose whether to use the disk in Independent Mode. 

6 If you chose to use the disk in Independent Mode, select Persistent or 
Nonpersistent disk mode:

! Persistent — Disks in persistent mode behave like conventional disk drives on 
your physical computer. All data written to a disk in persistent mode is 
written out permanently to the disk. 

NOTE If the hard disk you are configuring is the boot device for this virtual machine, click 
Modify the Device’s SCSI Node to change the SCSI Device node.
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! Nonpersistent — Changes to disks in nonpersistent mode are not saved to the 
disks. Changes are lost when the virtual machine is powered off or reset.

Nonpersistent mode is convenient for users who always want to start with a 
virtual machine in the same state. Example uses include providing known 
environments for software test and technical support users, as well as 
demonstrating software. 

7 Click OK to save your changes and return to the Summary tab. 

To edit an existing system LUN disk on an ESX 2.x virtual machine

1 Select the virtual machine you want to modify from the inventory panel.

2 On the Summary page, click the Hard Disk you want to modify.

The Hard Disk options appear under Commands.
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3 Click Edit.

The Hard Disk page appears.

4 Select the SCSI Device Node from the drop-down menu.

5 Choose the Disk Mode:

! Persistent — Disks in persistent mode behave like conventional disk drives on 
your physical computer. All data written to a disk in persistent mode are 
written out permanently to the disk. 

NOTE If the hard disk you are configuring is the boot device for this virtual machine, click 
Modify the Device’s SCSI Node to change the SCSI Device node.
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! Nonpersistent — Changes to disks in nonpersistent mode are not saved to the 
disks, but are lost when the virtual machine is powered off or reset.

Nonpersistent mode is for users who want to start with a virtual machine in 
the same state. Example uses include providing known environments for 
software test and technical support users, as well as demonstrating software.

! Undoable – Changes to disks in undoable mode can be saved, discarded, or 
appended when the virtual machine powers off.

! Append – Changes to disks in append mode are preserved in a redo log 
attached to the virtual disk.

6 Click OK to save your changes and return to the Summary tab. 

To remove an existing Hard Disk

1 Select the virtual machine you want to modify from the inventory panel.

2 Make sure the virtual machine is powered off.

3 On the Summary page, click the Hard Disk you want to remove.

The available hard drive configuration options appear under Commands.

4 Click Remove to remove the Hard Disk from the virtual machine, or click Delete 
from Disk to remove the Hard Disk from the virtual machine and delete the virtual 
disk file from the host computer.

Editing or Removing a SCSI Device
To edit an existing SCSI Device

1 Select the virtual machine you want to modify from the inventory panel.

2 On the Summary page, click the SCSI Device you want to modify.

The SCSI Device options appear under Commands.
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3 Click Edit.

The SCSI Device page appears.

4 Use the drop-down menu under Connection to specify the physical device you 
want to use.

5 Use the drop-down menu under Virtual Device to specify the SCSI Device node.

6 Click OK to update the SCSI Device settings and return to the Summary Tab.

To remove an existing SCSI Device

1 Select the virtual machine you want to modify from the inventory panel.

2 Make sure the virtual machine is powered off.

3 On the Summary page, click the SCSI Device you want to remove.

The available SCSI Device configuration options appear under Commands.

4 Click Remove.

Editing a SCSI Controller
To edit a SCSI controller’s configuration

1 Select the virtual machine you want to modify from the inventory panel.

2 On the Summary page, click the SCSI controller you want to modify. The available 
SCSI controller configuration options appear under Commands.
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3 Click Edit.

The SCSI controller configuration page appears.

4 Select the SCSI controller type in the list. 

Changing the SCSI controller type might prevent the virtual machine from booting. 

5 To specify whether the SCSI bus is shared, select the type of sharing in the SCSI Bus 
Sharing section:

! None — Virtual disks cannot be shared by other virtual machines. 

! Virtual — Virtual disks can be shared by virtual machines on the same server. 

! Physical — Virtual disks can be shared by virtual machines on any server. 

Depending upon the type of sharing, virtual machines can access the same virtual 
disk simultaneously on the same server or any server.

6 Click OK to save your changes and return to the Summary tab. 

Editing or Removing a Network Adapter
Virtual network adapters can be connected to a labeled network in much the same way 
that physical network adapters are connected by cables to wall jacks. By choosing a 
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labeled network for an adapter, you enable the guest operating system to reach the 
resources of the specified network.

To edit an existing Network Adapter on an ESX 3 virtual machine

1 Select the virtual machine you want to modify from the inventory panel.

2 On the Summary page, click the Network Adapter you want to modify.

The available Network Adapter configuration options appear under Commands.

3 Click Edit.

The Network Adapter page appears.

4 To connect this virtual machine to the network when the virtual machine is 
powered on, select Connect at power on. 

5 In the Network Connection list, select the virtual network device that you want 
the virtual machine to use. 

6 Click OK to add the Network Adapter and return to the Summary tab.

To edit an existing Network Adapter on an ESX 2.x virtual machine

1 Select the virtual machine you want to modify from the inventory panel.

2 On the Summary page, click the Network Adapter you want to modify.

The available Network Adapter configuration options appear under Commands.
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3 Click Edit.

The Network Adapter page appears.

4 To connect this virtual machine to the network when the virtual machine is 
powered on, select Connect at power on. 

5 In the Network Connection list, select the virtual network device that you want 
the virtual machine to use. 

6 In the Virtual Device list, select the network driver that you want the virtual 
machine to use. Choose either the vlance or vmxnet driver. 

7 Click OK to add the Network Adapter and return to the Summary tab.

To remove an existing Network Adapter

1 Select the virtual machine you want to modify from the inventory panel.

2 Make sure the virtual machine is powered off.

3 On the Summary page, click the Network Adapter you want to remove.

The available Network Adapter configuration options appear under Commands.

4 Click Remove.
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Editing or Removing a Parallel Port
To edit an existing Parallel Port

1 From the VI Web Access client, select the virtual machine.

2 On the Summary page, click the Parallel Port you want to modify.

The available Parallel Port configuration options appear under Commands.

3 Click Edit.

The Parallel Port page appears.

4 Under Device status, the default setting is Connect at power on.

Clear the check box to deselect this setting.

5 Choose the Connection Type.

! If you select Physical, use the drop-down menu to choose the port that will be 
used on the end user's host machine. 

! If you select File, type the path and filename, or browse to the location of the 
file. 

6 Click OK to save the updated settings and return to the Summary tab.

To remove an existing Parallel Port

1 Select the virtual machine you want to modify from the inventory panel.

2 Make sure the virtual machine is powered off.
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3 On the Summary page, click the Parallel Port you want to remove.

The available Parallel Port configuration options appear under Commands.

4 Click Remove.

Editing or Removing a Serial Port
You can set up the virtual Serial Port in a virtual machine to use a physical Serial Port 
on the host computer. This is useful, for example, if you want to use a modem or a 
handheld device in your virtual machine. 

To edit an existing Serial Port

1 Select the virtual machine you want to modify from the inventory panel.

2 On the Summary page, click the Serial Port you want to modify.

The available Serial Port configuration options appear under Commands.
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3 Click Edit.

The Serial Port page appears.

4 To connect the Serial port to the virtual machine when power it on, select Connect 
at power on.

5 Choose the connection type.

! If you select Physical, use the drop-down list to choose the port that will be 
used on the end user's host machine. 

! If you select File, type the path and filename, or browse to the location of the 
file. 
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! If you select Named Pipe, type the pipe name and use the drop-down list to 
choose the connection options.

i Under Near End, choose whether the application running in the guest 
operating system will function as a server or a client.

Select Is a server to start this end of the connection first.

Select Is a client to start the far end of the connection first.

ii Under Far End, specify where the application the virtual machine will 
connect to is located.

Select Is a virtual machine if the application the virtual machine will 
connect to is located on another virtual machine on the host.

Select Is an application if the application the virtual machine will connect 
to is running directly on the host machine.

6 Under I/O Mode, select whether to Yield CPU on poll.

The kernel in the target virtual machine uses the virtual serial port in polled mode, 
not interrupt mode.

7 Click OK to save the settings and return to the Summary tab.

To remove an existing Serial Port

1 Select the virtual machine you want to modify from the inventory panel.

2 Make sure the virtual machine is powered off.

3 On the Summary page, click the Serial Port you want to remove.

The available Serial Port configuration options appear under Commands.

4 Click Remove.

Adding Hardware to a Virtual Machine
Add virtual hardware to a virtual machine using the VI Web Access’s Add Hardware 
wizard.
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To start the wizard

1 From VI Web Access, select the virtual machine.

2 From the Summary tab, under Commands, click Add Hardware.

3 Double-click the type of hardware you want to add. 

4 Follow the steps in the wizard.

The following sections describe how to add virtual hardware to an existing virtual 
machine: 

! “Adding a Hard Disk” on page 68
! “Adding a Network Adapter” on page 85
! “Adding a CD/DVD Drive” on page 86
! “Adding a Floppy Drive” on page 89
! “Adding a Serial Port” on page 91
! “Adding a Parallel Port” on page 97
! “Adding a SCSI Device” on page 101

Adding a Hard Disk
You can add a new virtual disk, an existing virtual disk, or a mapped system LUN to 
the virtual machine.

To add a new virtual disk to an ESX 3 virtual machine

1 Select a virtual machine from the inventory panel.

2 From the Summary tab, under Commands, click Add Hardware.

The Add Hardware wizard opens.
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3 Double-click Hard Disk.

4 Select Create a new virtual disk, and click Next.

5 Specify the Capacity of the disk.

Disk Size must be specified in integers.

6 Choose the Location of the virtual disk:

! Choose Use the virtual machine’s datastore to install the virtual disk in the 
same location as the virtual machine.

! Choose Use a specific datastore to specify a location to install the virtual disk. 
Specify the datastore location by entering the path to the virtual disk, or click 
Browse and navigate to the datastore you want to use. 
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7 Click Next.

The Advanced Options panel displays the SCSI Device node and disk mode 
options. 

8 Select the SCSI Device Node from the drop-down menu.

9 Choose whether or not to run the disk in Independent Mode. Disks in 
Independent Mode are not affected by snapshots.

10 If you selected Independent Mode, choose one of the following:

! Persistent — Disks in persistent mode behave like conventional disk drives on 
your physical computer. All data written to a disk in persistent mode are 
written out permanently to the disk. 

! Nonpersistent — Changes to disks in nonpersistent mode are not saved to the 
disks, but are lost when the virtual machine is powered off or reset.

Nonpersistent mode is for users who want to start with a virtual machine in 
the same state. Example uses include providing known environments for 
software test and technical support users, as well as demonstrating software.
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11 Click Next.

12 Review the device configuration summary and click Finish to complete the 
wizard.

To add a new virtual disk to an ESX 2.x virtual machine

1 Select a virtual machine from the inventory panel.

2 Make sure the virtual machine is powered off.

3 From the Summary tab, under Commands, click Add Hardware.

The Add Hardware wizard opens.

4 Double-click Hard Disk.
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5 Select Create a new virtual disk, and click Next.

6 Specify the size and location of the disk.

Disk size must be specified in integers.

7 Specify the datastore location by entering the path to the virtual disk, or click 
Browse and navigate to the datastore you want to use.

8 Click Next.

The Advanced Options panel displays the SCSI Device node and disk mode 
options.

9 Select the SCSI Device Node from the drop-down menu.

10 Choose the Disk Mode:

! Persistent — Disks in persistent mode behave like conventional disk drives on 
your physical computer. All data written to a disk in persistent mode are 
written out permanently to the disk. 
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! Nonpersistent — Changes to disks in nonpersistent mode are not saved to the 
disks, but are lost when the virtual machine is powered off or reset.

Nonpersistent mode is for users who want to start with a virtual machine in 
the same state. Example uses include providing known environments for 
software test and technical support users, as well as demonstrating software.

! Undoable – Changes to disks in undoable mode can be saved, discarded, or 
appended when the virtual machine powers off.

! Append – Changes to disks in append mode are preserved in a redo log 
attached to the virtual disk.

11 Click Next.

12 Review the device configuration summary and click Finish to complete the 
wizard.

To add an existing virtual disk to an ESX 3 virtual machine

1 Select a virtual machine from the inventory panel.

2 If you are adding a Hard Disk to an ESX Server 2.x virtual machine, make sure the 
virtual machine is powered off.

3 From the Summary tab, under Commands, click Add Hardware.

The Add Hardware wizard opens.
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4 Double-click Hard Disk.

5 Select Use an existing virtual disk, and click Next.
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6 Browse to and select an existing virtual disk, and click Next.

The Advanced Options panel displays the SCSI Device node and disk mode 
options. 

7 Select the SCSI Device Node from the drop-down menu.

8 Choose whether to run the disk in Independent Mode.

9 If you selected Independent Mode, select Persistent or Nonpersistent disk mode:

! Persistent — Disks in persistent mode behave like conventional disk drives on 
your physical computer. All data written to a disk in persistent mode are 
written out permanently to the disk. 

! Nonpersistent — Changes to disks in nonpersistent mode are not saved to the 
disks, but are lost when the virtual machine is powered off or reset.

Nonpersistent mode is for users who want to start with a virtual machine in 
the same state. Example uses include providing known environments for 
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10 Click Next.

11 Review the device configuration summary and click Finish to complete the 
wizard.

To add an existing virtual disk to an ESX 2.x virtual machine

1 Select a virtual machine from the inventory panel.

2 If you are adding a Hard Disk to an ESX Server 2.x virtual machine, make sure the 
virtual machine is powered off.

3 From the Summary tab, under Commands, click Add Hardware.

The Add Hardware wizard opens.

4 Double-click Hard Disk.
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5 Select Use an existing virtual disk, and click Next.

6 Browse to and select an existing virtual disk, and click Next.

The Advanced Options panel displays the SCSI Device node and disk mode 
options. 

7 Select the SCSI Device Node from the drop-down menu. 

8 Choose the Disk Mode:

! Persistent — Disks in persistent mode behave like conventional disk drives on 
your physical computer. All data written to a disk in persistent mode are 
written out permanently to the disk. 
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! Nonpersistent — Changes to disks in nonpersistent mode are not saved to the 
disks, but are lost when the virtual machine is powered off or reset.

Nonpersistent mode is for users who want to start with a virtual machine in 
the same state. Example uses include providing known environments for 
software test and technical support users, as well as demonstrating software.

! Undoable – Changes to disks in undoable mode can be saved, discarded, or 
appended when the virtual machine powers off.

! Append – Changes to disks in append mode are preserved in a redo log 
attached to the virtual disk.

9 Click Next.

10 Review the device configuration summary and click Finish to complete the 
wizard.

To add a mapped system LUN to an ESX 3 virtual machine

1 Select a virtual machine from the inventory panel.

2 If you are adding a hard disk to an ESX Server 2.x virtual machine, make sure the 
virtual machine is powered off.

3 From the Summary tab, under Commands, click Add Hardware.

The Add Hardware wizard opens.
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4 Double-click Hard Disk.

5 Select Use a mapped system LUN, and click Next.
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6 Select the LUN to add to the virtual machine, and click Next.

7 Choose the file location:

! Use the virtual machine’s datastore – Install the virtual disk in the same 
location as the virtual machine.

! Use a specific datastore – Specify a location in which to install the virtual disk.

8 Click Next.
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9 Select the SCSI Device Node from the drop-down menu.

10 Choose the disk Compatibility:

! Physical – Allow the guest operating system to access the storage hardware 
directly.

! Virtual – Allow the virtual machine to take advantage of the features of 
virtual disks, such as snapshots and disk modes. For more information on 
virtual disks, see the Basic System Administration Guide.

11 If you chose Virtual compatibility, choose whether to run the disk in Independent 
Mode.

12 If you selected Independent Mode, choose the Persistent or Nonpersistent disk 
mode:

! Persistent — Disks in persistent mode behave like conventional disk drives on 
your physical computer. All data written to a disk in persistent mode are 
written out permanently to the disk. 

! Nonpersistent — Changes to disks in nonpersistent mode are not saved to the 
disks, but are lost when the virtual machine is powered off or reset.

Nonpersistent mode is for users who want to start with a virtual machine in 
the same state. Example uses include providing known environments for 
software test and technical support users, as well as demonstrating software.

! Undoable – Changes to disks in undoable mode can be saved, discarded, or 
appended when the virtual machine powers off.

! Append – Changes to disks in append mode are preserved in a redo log 
attached to the virtual disk.

13 Click Next.
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14 Review the device configuration summary and click Finish to complete the 
wizard.

To add a mapped system LUN to an ESX 2.5.x virtual machine

1 Select a virtual machine from the inventory panel.

2 If you are adding a hard disk to an ESX Server 2.x virtual machine, make sure the 
virtual machine is powered off.

3 From the Summary tab, under Commands, click Add Hardware.

The Add Hardware wizard opens.

4 Double-click Hard Disk.

Select Use a mapped system LUN, and click Next.
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5 Select the LUN to add to the virtual machine, and click Next.

6 Browse to the location where you would like to install the virtual disk, and click 
Next.

7 Select the SCSI Device Node from the drop-down menu.

8 Choose the disk Compatibility:

! Physical – Allow the guest operating system to access the storage hardware 
directly.

! Virtual – Allow the virtual machine to take advantage of disk modes and 
other features of virtual disks.
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9 If you chose Virtual compatibility, choose the Disk Mode:

! Persistent — Disks in persistent mode behave like conventional disk drives on 
your physical computer. All data written to a disk in persistent mode are 
written out permanently to the disk. 

! Nonpersistent — Changes to disks in nonpersistent mode are not saved to the 
disks, but are lost when the virtual machine is powered off or reset.

Nonpersistent mode is for users who want to start with a virtual machine in 
the same state. Example uses include providing known environments for 
software test and technical support users, as well as demonstrating software.

! Undoable – Changes to disks in undoable mode can be saved, discarded, or 
appended when the virtual machine powers off.

! Append – Changes to disks in append mode are preserved in a redo log 
attached to the virtual disk.

10 Click Next.

11 Review the device configuration summary and click Finish to complete the 
wizard.
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Adding a Network Adapter
To add a Network Adapter

1 Select a virtual machine from the inventory panel.

2 From the Summary tab, under Commands, click Add Hardware.

The Add Hardware wizard opens.

3 Double-click Network Adapter.

4 Select the network interface card.

To have the network adapter connected to the virtual machine when you power it 
on, select Connect at power on.



Virtual Infrastructure Web Access Administrator’s Guide

86 VMware, Inc.  

5 Click Next.

6 Click Finish to add the Network Adapter.

Adding a CD/DVD Drive
You can add up to four CD/DVD drives to your virtual machine. You can connect the 
virtual machine's drive to a physical drive or ISO image on your host machine or on the 
machine where you are running your browser.

To add a CD/DVD Drive to a virtual machine

1 Make sure the virtual machine is powered off.

2 Select a virtual machine from the inventory panel.

3 From the Summary tab, under Commands, click Add Hardware.

The Add Hardware wizard opens.
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4 Double-click CD/DVD Drive.

5 Choose one of the Media Type options:

! Select an option under Host Media to connect to a drive or ISO image on the 
ESX host.

! Select Use a physical drive to connect the virtual machine's drive to a 
physical drive on the host computer. 

! Select Use an ISO image to connect the virtual machine's drive to an ISO 
image file on the host computer.

! Select an option under Client Media to connect to a drive or ISO image on the 
client computer.

! Select Use a physical drive to connect the virtual machine's drive to a 
physical drive on the client computer. 

! Select Use an ISO image to connect the virtual machine's drive to an ISO 
image file on the client computer.

6 Click Next.

NOTE Client Media options are not available on ESX 2.x virtual machines.
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7 If you selected Use a physical drive, specify the drive you want to use and indicate 
whether the system should connect the device when the virtual machine powers 
on. 

8 Click Next.

9 If you selected Use an ISO Image, type the path and filename for the image file or 
click Browse to navigate to the file.

To have the drive connected to the virtual machine when you power it on, select 
Connect at power on. 

10 Click Next.

The Advanced Options page appears.

11 Choose the virtual device node from the drop-down menu.
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12 Click Next.

The Ready to Complete page appears and displays the device settings.

13 Click Finish to add the CD/DVD Drive to your virtual machine.

Adding a Floppy Drive
You can connect a Floppy Drive in your virtual machine to a physical drive or floppy 
image on the host machine or on the machine where you are running your browser.

To add a new virtual Floppy Drive to a virtual machine

1 Make sure the virtual machine is powered off.

2 Select a virtual machine from the inventory panel.

3 From the Summary tab, under Commands, click Add Hardware.

The Add Hardware wizard opens.
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4 Double-click Floppy Drive.

5 Choose one of the Media Type options:

! Select an option under Host Media to connect to a drive or floppy image on 
the ESX host.

! Select Use a physical drive if you want to connect the virtual machine's 
drive to a physical drive on the host computer. 

! Select Use an existing floppy image if you want to connect the virtual 
machine's drive to a floppy image file on the host computer.

! Select Create a blank floppy image if you want to connect the virtual 
machine's drive to a new, blank floppy image file on the host computer.

! Select an option under Client Media to connect to a drive or floppy image on 
the client computer.

! Select Use a physical drive if you want to connect the virtual machine's 
drive to a physical drive on the client computer. 
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! Select Use an existing floppy image if you want to connect the virtual 
machine's drive to a floppy image file on the client computer.

! Select Create a blank floppy image if you want to connect the virtual 
machine's drive to a new, blank floppy image file on the client computer.

6 Click Next.

7 Select the type of floppy media. To have the Floppy Drive connected to the virtual 
machine when you power it on, select Connect at power on.

8 Click Finish to add the Floppy Drive to your virtual machine.

Adding a Serial Port
You can set up the virtual serial port in a virtual machine to use a physical serial port 
on the host computer, an output file on the host computer, or an application running in 
the virtual machine or another virtual machine on the host computer. 

NOTE Client Media options are not available on ESX 2.x virtual machines.

NOTE Connect at power on is not available with client media.
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To add a physical Serial Port to the virtual machine’s configuration

1 Make sure the virtual machine is powered off.

2 Select a virtual machine from the inventory panel.

3 From the Summary tab, under Commands, click Add Hardware.

The Add Hardware wizard opens.

4 Double-click Serial Port.

The Serial Port page appears.

5 Choose Use a physical serial port to connect to a physical port on the host 
machine, and click Next.
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6 To connect this virtual machine to the host's Serial Port when the virtual machine 
is powered on, select Connect at power on, and click Next.

7 Under I/O Mode, select whether to Yield CPU on poll.

The kernel in the target virtual machine uses the virtual Serial Port in polled mode, 
not interrupt mode.

8 Click Next.

9 Click Finish to add the Serial Port to your virtual machine. 

To add an output file Serial Port to the virtual machine’s configuration

1 Make sure the virtual machine is powered off.

2 Select a virtual machine from the inventory panel.

3 From the Summary tab, under Commands, click Add Hardware.

The Add Hardware wizard opens.
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4 Double-click Serial Port.

The Serial Port page appears.

Choose Output file to connect to a physical port on the host machine, and click 
Next.

5 Enter the location of the output file, or browse for a location in the Output File 
field. 

To connect this virtual machine to the host’s output file when the virtual machine 
is powered on, select Connect at power on, and click Next.
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6 Under I/O Mode, select whether to Yield CPU on poll.

The kernel in the target virtual machine uses the virtual Serial Port in polled mode, 
not interrupt mode.

7 Click Next.

8 Click Finish to add the Serial Port to your virtual machine. 

To add a named pipe Serial Port to the virtual machine’s configuration

1 Make sure the virtual machine is powered off.

2 Select a virtual machine from the inventory panel.

3 From the Summary tab, under Commands, click Add Hardware.

The Add Hardware wizard opens.

4 Double-click Serial Port.

The Serial Port page appears.
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5 Choose Use a named pipe to connect to a physical port on the host machine, and 
click Next.

6 To specify a named pipe, enter the pipe name. 

7 Under Near End, choose whether the application running in the guest operating 
system will function as a server or a client.

! Select Is a server to start this end of the connection first.

! Select Is a client to start the far end of the connection first.

8 Under Far End, specify where the application the virtual machine will connect to 
is located.

! Select Is a virtual machine if the application the virtual machine will connect 
to is located on another virtual machine on the host.

! Select Is an application if the application the virtual machine will connect to 
is running directly on the host machine.



VMware, Inc. 97

Chapter 5 Editing an Existing Virtual Machine’s Configuration

  

9 To connect this virtual machine to the named pipe when the virtual machine is 
powered on, select Connect at power on, and click Next.

10 Under I/O Mode, select whether to Yield CPU on poll.

The kernel in the target virtual machine uses the virtual Serial Port in polled mode, 
not interrupt mode.

11 Click Next.

12 Click Finish to add the physical Serial Port to your virtual machine. 

Adding a Parallel Port
Parallel Ports are used by a variety of devices, including printers, scanners, dongles, 
and disk drives. 

The virtual Parallel Port can connect to a Parallel Port or to a file on the host operating 
system.

To add a physical Parallel Port to the virtual machine's configuration

1 Make sure the virtual machine is powered off.

2 Select a virtual machine from the inventory panel.
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3 From the Summary tab, under Commands, click Add Hardware.

The Add Hardware wizard opens.

4 Double-click Parallel Port.

The Parallel Port page appears.

5 In the Connection Type list, select Use a physical Parallel Port, and click Next.

6 Enter the location of the device in the Location field.

For example, the host's Parallel Port could be /dev/parport0.
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7 To connect this virtual machine to the host's Parallel Port when the virtual machine 
is powered on, select Connect at power on, and click Next.

8 Click Finish to add the Parallel Port.

To add an output file Parallel Port to the virtual machine's configuration

1 Make sure the virtual machine is powered off.

2 Select a virtual machine from the inventory panel.

3 From the Summary tab, under Commands, click Add Hardware.

The Add Hardware wizard opens.
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4 Double-click Parallel Port.

The Parallel Port page appears.

5 In the Connection Type list, select Output File, and click Next.

6 Enter the path and filename in the Output File field, or browse to the location of 
the file.

7 To connect this virtual machine to the host's Parallel Port when the virtual machine 
is powered on, select Connect at power on, and click Next.

8 Click Finish to add the Parallel Port.
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Adding a SCSI Device
To add a SCSI Device to a virtual machine’s configuration

1 Select a virtual machine from the inventory panel.

2 If you are adding a SCSI Device to an ESX Server 2.x virtual machine, make sure 
the virtual machine is powered off.

3 From the Summary tab, under Commands, click Add Hardware.

The Add Hardware wizard opens.

4 In the Add Hardware wizard, double-click SCSI Device.

5 Under Physical Device, use the drop-down menu to select the physical device you 
want to use.
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6 To connect this virtual machine to this SCSI Device when the virtual machine is 
powered on, select Connect at power on, and click Next.

7 Under Virtual Device, select the virtual device node where you want this device 
to appear in the virtual machine, and click Next.

8 Click Finish to add the SCSI Device.

Changing Virtual Machine Options
Configuration options let you adjust characteristics of the selected virtual machine, 
such as the virtual machine general settings, power options, and advanced options. The 
options are described in the following sections: 

! “Changing General Settings” on page 102

! “Changing Power State Options” on page 103

! “Changing Advanced Settings” on page 104

Changing General Settings
The Options tab lets you adjust characteristics of the selected virtual machine. You must 
power off the virtual machine before you can make any changes.
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To change general settings

1 In the Summary tab, in the Commands section, click Configure Options.

2 Click General.

The General Options options page appears.

3 To change the display name, type a new name in the Virtual Machine Name field.

4 To change the guest operating system installed on the virtual disk (for example, if 
you are upgrading the guest operating system), select the new guest operating 
system from the Guest Operating System list.

When you change the operating system type using the Version list, only the setting 
for the guest operating system type in the virtual machine’s configuration file is 
changed. The guest operating system itself is not changed. See the Basic System 
Administration Guide and the Guest Operating System Installation Guide for 
information about installing the guest operating system. 

5 Click OK to save your changes and return to the Summary tab. 

Changing Power State Options
Power state options allow you to define actions that occur in various virtual machine 
power states.
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To change power state options

1 In the Summary tab, in the Commands section, click Configure Options.

2 Click Power.

The Power Options page appears.

3 Choose the default power off option for the virtual machine.

Settings for powering off virtual machines include Power off the virtual machine 
and Shut down the guest operating system. By default, all virtual machines are 
powered off without shutting down the guest operating system. When VMware 
Tools is running, the virtual machine shuts down the guest operating system by 
default.

4 Choose the reboot option for the virtual machine.

Settings for rebooting virtual machines include Reset the virtual machine to 
reboot the virtual machine without shutting down the guest operating system and 
Restart the guest operating system to restart the guest operating system. By 
default, all virtual machines are rebooted without shutting down the guest 
operating system. When VMware Tools is running, the virtual machine restarts the 
guest operating system by default.

5 Choose to run a VMware Tools script either After resuming or Before 
suspending. 

Changing Advanced Settings
To change advanced virtual machine configuration options, complete the following 
steps.
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To change advanced settings

1 In the Summary tab, in the Commands section, click Configure Options.

2 Click Advanced.

The Advanced Options page appears.

3 Select an option:

! Run with debugging information — Runs the virtual machine with 
debugging information, which is useful when you are experiencing problems 
with this virtual machine. You can then provide this information to VMware 
support to troubleshoot any problems you are experiencing. 

! Enable logging — Enables logging for the virtual machine. 

! Disable acceleration — Disables acceleration in the virtual machine. You 
might want to temporarily disable acceleration in a virtual machine if you try 
to install or start a program in a virtual machine and the program seems to 
hang or crash or reports that it is running under a debugger. VMware has seen 
this problem with a few programs. Generally, the problem occurs early in the 
program's execution. In many cases, you can get past the problem by 
temporarily disabling acceleration in the virtual machine.

This setting slows virtual machine performance, so use it only for getting past 
a problem with running the program. After you stop encountering problems, 
return to the virtual machine settings editor and deselect Disable 
acceleration. You might then be able to run the program with acceleration. 
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